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Editor’s Letter 

 
 

We continue the Stribling Funeral Home Records, Alto Texas from August 1929 to August 

1933 and from September 1937 through 1941 compiled by Ogreta W. Huttash.  Mrs. Huttash 

also transcribed the deed from Thos E. Wiggins, Gdn to K. & G. S. K RR Co. 

 

New member, Deborah L. Burkett, shares two images of her ancestors.  First is a picture taken 

in 1916 of Joe Lee Langston and his sons and second is a photograph of the Langston or Long 

home, circa 1904.  

 

We continue printing the Applications to the Daughters of the Republic of Texas by Bettye Jo 

Collier Smith, and Georgie Gene Watters Uzzle.   

 

Ida Lee Derrett Edmiston has given us permission to print her application to the U.S. Daughters 

of the American Revolution. 

 

I found Mildred Nicar Bertolino’s letter to Stella Hill Memorial Library and her account of the 

Ferris Farm in the Ogreta W. Huttash Archives. 

 

 

Gordon Bennett 

 Editor 

August  2011 
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Stribling Funeral Home Records, Alto Texas 

Compiled by Ogreta W. Huttash 
Continued from Volume 36, Issue 1 
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Stribling Funeral Home Records, Alto Texas 
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Stribling Funeral Home Records, Alto Texas 



TREE TALK       Volume 36 Issue 2              Winter 2010-2011       Page  42     

 

Stribling Funeral Home Records, Alto Texas 

From the Archives of Ogreta W. Huttash in the Genealogy Section at the Jacksonville, Texas Public Li-

brary. Catalog number 929.3764 Hu 168 in the name of Funeral Home Records, Alto Texas. 
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Langston and Long Families in Cherokee County, Texas  
Submitted by Deborah L. Burkett 

Photograph of Langston men, 1916- All Born in Mixon, the Langstons in 

this photograph were indicative of early Texas families who placed an emphasis 

on education. Left to right are Joe Lee Langston, born 1873 and father to Willie 

(standing) born 1897, Claud born 1899, and in the middle is youngest brother, 

Aaron, born in 1909.  

For many years Joe Lee was Trustee at MIxon School.  His sons served 

Cherokee County and the state by dedicating their careers to education and to-

gether amassed well over 100 years of service. Claud Langston also served as 

Cherokee County School Superintendent.  

 The following is a portion of family records Deborah has collected; she has 

much work to do.  If you have any information please contact her at  

debbietroup7@yahoo.com  

Langston, Willie D. 5-25-1897 d. 10-16-1962--Tex-Pvt-US Army-WW I. 

Langston, Claud L. 7-4-1899 d. 2-16-1979--HA2 US Navy.  

Musick, Eula Langston 1901-_____ married Addis L. 12-27-1919. 

Langston, Joe Lee 7-14-1873 d. 5-6-1943 & Langston, Julia S. 7-27-1878 d. 2-

27-1958. 

Bugg, Lillie Langston 5-28-1885 d. 2-15-1970 

mailto:debbietroup7@yahoo.com
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Langston and Long Families in Cherokee County, Texas  

  Family Home-Standing on the porch, third from the left is Deb-

orah’s grandfather as a young boy, Willie Dixon Langston. Next to him 

and fourth from the left is his brother, Claud.   

Next are their parents, Joe Lee and Julie Smith Long Langston, 

who are standing behind the picket fence.  Joe Lee has a mustache and 

a black bow tie and is holding Willie and Claud’s baby sister, Eula.  His 

wife, Julie is next and her image is slightly blurred.   Next is Lillie 

Langston, her dress has a black collar and she is holding an unnamed 

baby. Lillie later married a Bugg.  Moving on down behind the fence 

are Longs or Langstons who are not identified at the present time.  

Interesting to note the beautiful and well fed hunting dogs!  Also 

of note in the far right front, kneeling upright is John W. Langston with 

his dog and rifle.  John W. later served as Sheriff of Troup Texas.   

 
Submitted by  Deborah L. Burkett, P.O. Box 325, Troup, TX 75789, debbietroup7@yahoo.com 
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Bettye Jo Collier Smith application to 

Daughters of the Republic of Texas 
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Bettye Jo Collier Smith application to 

Daughters of the Republic of Texas 

From the Archives of Ogreta W. Huttash in the Genealogy Section at the Jacksonville, Texas Public Li-

brary. Catalog number 929.3764 Hu 136 in the name of DRT-Daughters of the Republic. Used by per-

mission of Bettye Collier Smith, 1046 Edgewood Dr., Jacksonville, TX 75766. 
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Applying Watermarks to Documents and Images  
By Mary Harrell-Sesniak 

A cousin once sent a document sharing a family lineage. This was exciting, except for one thing 

-- he had inadvertently e‑mailed my own research to me! 

 

"How funny," I thought. "I did all that work, and didn't get the credit!"  

 

We had a good laugh over the incident, but it taught me a lesson -- always identify documents 

and photos, as to authorship and ownership, before e-mailing. You can do this through a variety 

of methods, but one of the more common techniques is by adding a watermark. 

 

Watermarks are text messages or images superimposed or placed behind documents and pic-

tures. Some programs allow you to type the content and others require you to use a graphic im-

age. The text can be anything you choose -- from a simple message to a full copyright.  

 

            From the files of [your name] as of [date] 

            Copyrighted by [your name], [date] 

 

If you are required to use a graphic, then create one in a graphics program or purchase from a 

service. I created this graphic in OpenOffice.Org Draw - you are welcome to adapt it for your 

own purposes (no credit necessary). 

 
Depending upon your software version, the steps should be similar to these.  

 

Microsoft Word 

2010:  

(text or graph-

ics)  

Select the Page Layout Ribbon > Watermark > Custom Watermark > Select Picture > 

Locate a picture > Insert >  

Determine a percentage for scaling > Apply any additional options, such as Scale to 

change the size of the picture or Washout to dim the picture  

 

To remove the watermark: Page Layout Ribbon > Watermark > Remove Watermark 

 

For more detailed instructions, see 

http://office.microsoft.com/en-us/word-help/insert-a-watermark-or-change-a-

watermark-HA101854787.aspx?CTT=1  

 

For information on early versions of Word, see 

http://support.microsoft.com/kb/211324  

http://link.rootsweb.com/u.d?IYGm821UW1Sok_8OnXUWY=14141
http://link.rootsweb.com/u.d?IYGm821UW1Sok_8OnXUWY=14141
http://link.rootsweb.com/u.d?DYGm821UW1Sok_8OnXUWl=14151
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Applying Watermarks to Documents and Images  

 

Microsoft Works 9: 

(limited to graphics)  

Insert > Watermark > Picture Watermark > Select Picture > Select desired 

size & position on the page 

 

[You can also elect to fade the image or tile it (repeat) on the page.] 

 

To remove the watermark: Insert > Watermark > No watermark  

OpenOffice.org 

Writer 3:  

(limited to graphics)  

Format > Page > Background Tab > Select background graphic by chang-

ing "Color" to "As" > Graphic > Browse [select a picture from your com-

puter] > Select position, area or tile  

[You can select the position on the page, for the watermark to extend over 

the available area or to tile it (repeat) on the page.] 

To remove the watermark: Format > Page > As Color > No Fill  

Embedding watermarks in pictures can be accomplished through imaging software, such as 

PhotoShop, or by accessing a free online service, such as PicMarkr.com or watermark-

images.com.   

If you choose an imaging program, the basic process involves manipulating layers (one for the 

image and one for the watermark), and then adjusting the opacity (brightness and see-through 

qualities), along with other options. 

For those who do not plan to create watermarks on a frequent basis, I recommend trying an 

online service. 

http://link.rootsweb.com/u.d?bYGm821UW1Sok_8OnXUWu=14161
http://link.rootsweb.com/u.d?T4Gm821UW1Sok_8OnXUWr=14171
http://link.rootsweb.com/u.d?T4Gm821UW1Sok_8OnXUWr=14171
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Applying Watermarks to Documents and Images  

The watermark for this graphic was created in PicMarkr Beta,which allows you to upload an 

image from your computer or to interface with Facebook, Flickr or Picasa. The subsequent 

steps involved entering the desired text and selecting the location where it should appear on the 

image. In addition, I was able to adjust the size and appearance before saving the picture back 

to the computer. It was a straight-forward process, and I was pleased with the results. 

 

Watermarks can also be applied to PDF (portable document format) files using Adobe Acrobat 

and a variety of other commercial programs. A general Web search uncovered several offering 

free trials prior to purchase. For those working with a large quantity of files look for the ability 

to "stamp" multiple files with the same watermark.  

 

Beyond watermarking, consider adding identifying headers or footers (a message appearing 

above or below the text on each page), and adding your personal name to file names. And re-

member to always include yourself as preparer in genealogy reports!  

 

Previously published in RootsWeb Review: 11 May 2011, Vol. 14, No. 5  Used by permission. 
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IdaLee Derrett Edmiston application to 

U.S. Daughters of the American Revolution 
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IdaLee Derrett Edmiston application to 

U.S. Daughters of the American Revolution 

From the Archives of Ogreta W. Huttash in the Genealogy Section at the Jacksonville, Texas Public Li-

brary. Catalog number 929.3764 Hu 326 in the name of Price, William M 2.. Used by permission of 

IdaLee D. Edmiston, 204 Forest Smouth Dr., Whitehouse, TX 75791-3708 July 20, 2011. 
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 Thos E. Wiggins, Gdn deed to K. & G. S. L. RR Co. 

Transcribed by Ogreta W. Huttash 
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Thos E. Wiggins, Gdn deed to K. & G. S. L. RR Co. 
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Thos E. Wiggins, Gdn deed to K. & G. S. L. RR Co. 
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Thos E. Wiggins, Gdn deed to K. & G. S. L. RR Co. 
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Thos E. Wiggins, Gdn deed to K. & G. S. L. RR Co. 



TREE TALK       Volume 36 Issue 2            Winter 2010-2011      Page 57     

 

Visit our Internet site at: 

http://www.txgenweb2.org/txcherokee/ 

Thos E. Wiggins, Gdn deed to K & G, S, K. RR Co. 

From the Archives of Ogreta W. Huttash in the Genealogy Section at the Jacksonville, Texas Public Li-

brary. Catalog number 929.3764 Hu 332 in the name of  P-Miscellaneous. 
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 Morrell Orchard and Ferris Farm 
By Mildred Nicar Bertolino 
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 Morrell Orchard and Ferris Farm 
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Morrell Orchard and Ferris Farm 
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Morrell Orchard and Ferris Farm 



TREE TALK       Volume 36 Issue 2              Winter 2010-2011       Page  62     

 

Morrell Orchard and Ferris Farm 
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Morrell Orchard and Ferris Farm 
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Morrell Orchard and Ferris Farm 
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Morrell Orchard and Ferris Farm 
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Morrell Orchard and Ferris Farm 
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Morrell Orchard and Ferris Farm 

From the Archives of Ogreta W. Huttash in the Genealogy Section at the Jacksonville, Texas Public Li-

brary. Catalog number 929.3764 Hu 155 in the name of  in the name of Ferris Farm. 

 

Used by permission of Stella Hill Memorial Library by Virginia Singletary, July 26, 2011. 
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Georgie Gene Watters Uzzle application to 

Daughters of the Republic of Texas 

From the Archives of Ogreta W. Huttash in the Genealogy Section at the Jacksonville, Texas Public Li-

brary. Catalog number 929.3764 Hu 136 in the name of DRT-Daughters of the Republic of Texas.  Used 

by permission of Georgie Gene Uzzle, April 6, 2011. 
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Publications available through CHEROKEE COUNTY GENEALOGICAL SOCIETY 

  P.O. Box 1332, Jacksonville, Texas 75766-1332 

 

___1850 CHEROKEE CO. FED. CENSUS & MORTALITY SCHEDULE, by Sue Taylor, 76 pgs, (1986)indexed  
 ISBN 1-931167-05-2          $10.00 

___1860 CHEROKEE CO. FED CENSUS & SLAVE SCHEDULE, 131 pgs, indexed. ISBN 1-931167-06-0   $11.00 

___1870 Cherokee County Federal Census, Agricultural Schedule, Mortality Schedule and Tax Rolls, by Sue Vaughn Taylor and Ira Gaylon  
 White, 150 pages  (1999) indexed  ISBN 1-931167-07-9      $11.00 

___1880 CHEROKEE CO. FED. CENSUS, by Sue Taylor, 504 pgs. plus pgs of column explanations & abbreviation explanations:  

 other introductory pgs., (1983) indexed. ISBN 1-931167-09-7         $38.00 
___1910 CHEROKEE CO. FED. CENSUS, by Bobbie Berry Dowling & Ira Gaylon White, 265 pgs, plus 3 pgs of column explanations,  

 (1998), indexed   ISBN 1-931167-09-5         $24.00 

___AN ALBUM OF CHEROKEE COUNTY, TX MEN & WOMEN WHO SERVED IN WW 11, THE KOREAN CONFLICT OR  
 VIET NAM (1994), n avy with white imprint, red tape binder, 260 pgs., softbound, indexed. ISBN 1-931167-00-1 $21.00 

 

___Cemeteries of NW Cherokee County by Helen Wooddell Crawford Book 1     $10.00 
___Cemeteries of Jacksonville, and others by Helen Wooddell Crawford Book 2     $  8.00 

___Cemeteries of NE Cherokee County by Helen Wooddell Crawford Book 3     $11.00 

___Cemeteries of Mid Cherokee County by Helen Wooddell Crawford Book 4           $10.00 

___Cemeteries of Southern Cherokee County by Helen Wooddell Crawford Book 5     $  8.00 

___CHEROKEE COUNTY DEATH RECORDS, 1903-1945, by IdaLee D. Edmiston (1998) 351 pgs., softbound, approximately  

 alphabetical ISBN 1-931167-10-9        $31.00 
___Church Book for Church of Christ at Salem Edgefield District South Carolina To Sardis Baptist Church at Cherokee County, Texas A.D. 

 1836- A.D. 1941: copy of original handwritten minutes, names of members, pastors; 260 letter-size pages, softbound, 3rd  

 edition, (2006) indexed by Sue Taylor & Bobbie Dowling ISBN 1-931167-15-X  LCCN 2006928721  $22.00 
___CHURCH BOOK OF PLEASANT GROVE BAPTIST CHURCH CHEROKEE CO., TX. VOL. 1, Sep. 1854 to Feb. 1921. Copy of  

 original handwritten minutes of the church, names of pastors, roster of members, obituary notices on some members,  
 introductory pages includes a brief history of the church, surrounding area, and map of location, 452 pgs, (1992), softbound,  

 indexed. ISBN 1-931167-O1-X          $39.00 

___CHURCH BOOK OF PLEASANT GROVE BAPTIST CHURCH, CHEROKEE CO., TX. VOL. II, Mar. 1921 to Apr. 1961. Copy  
 of original handwritten minutes of the church, names of pastors, roster of members, obituary notices on some members,  

 (Introductory pgs. the same as VOL. I above), 500 pgs, softbound, indexed ISBN 1-931167-02-8   $40.00 

___CHURCH BOOK OF ROCKY SPRINGS MISSIONARY BAPTIST CHURCH, CHEROKEE CO., TX 1871-1912, copy of original  
 handwritten minutes, names of pastors, roster of members, 351 pgs, softbound, (1991) indexed by IdaLee Derrett Edmiston  

 ISBN 1-931167-03-6           $28.00 

___CIVIL WAR RECORDS OF CHEROKEE CO., TX, VOL. 1. by Ogreta W. Huttash, 93 pgs, (1982). Most complete list from  
 soldiers from Cherokee county available, plus interesting documents from individuals, softbound, indexed.  $14.00 

___CIVIL WAR RECORDS OF CHEROKEE CO., TX, VOL. 11, PENSIONS. by Ogreta W. Huttash, 115 pgs, (1982). Summary of  

 over 700 pension applications by veterans & widows who lived in Cherokee County, softbound, indexed.  $15.00  
___COMMISSIONERS COURT MINUTES, No. 1, Cherokee co., TX, 12 Oct. 1846 through a called session 4 Feb. 1850. A verbatim  

 copy which  lists the  first 37 land certificates, precincts and their boundaries, patrol captain, road workers, overseers,  

 prisoners, etc. 86 pgs, by Ogreta W.  Huttash, (I 989) softbound, indexed     $12.00 
___Early probates & wills of Cherokee County, compiled from the original papers by Helen Wooddell Crawford ISBN  978-1-931167-47-5 

            $20.00 

___Federal Census of Cherokee County, 1870 by Helen Crawford, 154 pages (1983) plus surname index.    $10.00 
___FIRST RECORDED MINUTES OF THE DISTRICT COURT OF CHEROKEE CO., TX A verbatim copy of the original book in  

 the office of the  Dist. clerk, Rusk, TX Oct. 1846 through Nov. 1848, by Ogreta W. Huttash, 112 pgs, (1987), softbound,  

 indexed           $12.00 
___GRAVE MARKER INDEX FOR CHEROKEE COUNTY TEXAS, (2000), by Ira Gaylon White, edited by Gordon Bennett. An  

 alphabetical listing of 29,484 markers from 15 published sources. 476 pgs., softbound, ISBN 0-9703085-7-4  $25.00 

___GRAVE MARKER INDEX FOR CHEROKEE COUNTY TEXAS, (2000), by Ira Gaylon White, edited by Gordon Bennett. An  
 alphabetical listing of 29,484 markers from 15 published sources. 1 CD-ROM, ISBN 1-931167-12-5   $15.00 

___HISTORICAL MARKERS OF CHEROKEE COUNTY, TX. by Ogreta W. Huttash. Contains inscriptions on the 103 state  

 approved markers erected before 1995. 2000 edition, full name index.     $12.00 
 $30.00 

___Index to TREE TALK, May 1980 through December 1990, compiled by Sylvia Booth Acker and Ira Gaylon White, edited by  

 Gordon Bennett (2004), 146 pgs., softbound, ISBN 1-931167-33-8, LCCN 2004104368    $12.00  

___Larissa College 1857-1860  (This material is a compiled book of articles printed of Larissa College, and in 1915 it was said that  

 this was the only material on the college. It has the names  of the Board, teachers, visitors & children.)  

 by Helen Crawford          $  7.00 
 

___Marriage Records of Cherokee County Texas 1905-1931 (2001) by Sylvia Booth Acker, Melva Hermes, and Ira Gaylon White.  

 Edited  by Gordon Bennett. A listing of 8,192 marriages 262 pgs., softbound, ISBN 1-931167-14-1   $17.00 
___Marriage Records of Cherokee County Texas 1905-1931 (2001) by Sylvia Booth Acker, Melva Hermes, and Ira Gaylon White.  

 Edited   by Gordon Bennett. A listing of 8,192 marriages. 1 CD-ROM, ISBN 1-931167-16-8   $15.00 

___MARRIAGE RECORDS OF CHEROKEE CO., TX, 1846-1880, VOL. 1. by Ogreta W. Huttash. 100 pgs, copyright 1974, fifth Printing,  
 1985,  Approximately 4,000 marriages alphabetically by name of groom: full-name index of brides.  $14.00 

___MARRIAGE RECORDS OF CHEROKEE CO., TX, 1881-1905, VOL. 11. by Ogreta W. Huttash. 127 pgs, copyright 1976,  

 Approximately   5800 marriages alphabetically by name of groom: full-name index of brides.   $17.00 
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___National Tomato Capital 305 pgs Tomato history in Cherokee County by Helen Wooddell Crawford   $29.00 
___Newspaper Obituaries from early papers 1889-1908   Bk.1 166 pgs by Helen Wooddell Crawford ISBN 1-931167-18-4  $16.00 

___Newspaper Obits 1910-1921,  Bk 2  309 pgs by Helen Wooddell Crawford    ISBN 1-931167-29-X    $25.00 

___Newspaper Obits assorted dates Bk 3 260 pgs by Helen Wooddell Crawford ISBN 1-931167-30-3  $20.00 
___Newspaper Obits   Bk.4  469 pgs by Helen Wooddell Crawford ISBN 1-931167-31-1  $44.00 

___Newspaper Obits   Bk 5 495 pgs by Helen Wooddell Crawford ISBN 1-931167-32-X  $25.00 

___Newspaper Obits 1922-1925  Bk 6 182 pgs by Helen Wooddell Crawford ISBN  978-1-931167-25-3 $16.00 
___Newspaper Obits assorted dates Bk 7 368 pgs by Helen Wooddell Crawford  ISBN  978-1-931167-50-5 $29.00 

___Newspaper Obits  1991 & part of 1990   Bk 8  256 pgs  by Helen Wooddell Crawford  ISBN 978-1-931167-49-9 $20.00 

___Newspaper Obits  1992  Bk 9  194 pgs by Helen Wooddell Crawford ISBN 978-1-931167-51-2 $18.00 
___Newspaper Obits  1993 Bk 10 209 pgs  by Helen Wooddell Crawford  ISBN 1-931167-23-0  $16.00 

___Newspaper Obits  1994 Bk 11 206 pgs  by Helen Wooddell Crawford  ISBN 1-931167-22-2  $16.00 

___Newspaper Obits 1995 Bk 12 205 pgs  by Helen Wooddell Crawford    ISBN  978-1-931167-43-7 $16.00 
___Newspaper Obits  1996 Bk 13 226 pgs  by Helen Wooddell Crawford    ISBN 1-931167-21-4  $18.00 

___Newspaper Obits 1997 Bk 14 197   pgs by Helen Wooddell Crawford   ISBN 1-931167-20-6   $16.00 

___Newspaper Obits  1998 Bk 15 205 pgs by Helen Wooddell Crawford ISBN 978-1-931167-39-0 $16.00 
___Newspaper Obits 1999 Bk 16  196 pgs  by Helen Wooddell Crawford  ISBN 1-931167-19-2  $16.00 

___Newspaper Obits  2000 Bk 17  215 pgs by Helen Wooddell Crawford    ISBN 1-931167-40-0  $17.00 

___Newspaper Obits  2001 Bk 18 221 pgs  by Helen Wooddell Crawford , soft cover, Indexed ISBN 1-931167-13-3  $19.00 
___Newspaper Obits  1926-1931  Bk 19 177 pgs  by Helen Wooddell Crawford  ISBN 1-931167-17-6  $16.00 

 

     
 ___Newspaper Obituaries Index of Cherokee County, Texas 1836-2001  BOOKS  1-19       by Helen Wooddell Crawford   

 ISBN 1-931167-36-2                $22.00 

___Newspaper Obituaries Index of Cherokee County, Texas 1836-2001  BOOKS  1-19 CD-ROM      by Helen Wooddell Crawford   
 ISBN 1-931167-37-0,          $15.00 

___NORTHWEST CHEROKEE CO. CEMETERIES, VOL. 1, 20 cemeteries (1997), by Ira Gaylon White, 253 pgs, softbound, indexed  
 ISBN 0-9703095-8-2          $35.00 

___NORTHWEST CHEROKEE CO. CEMETERIES, VOL. II 25 cemeteries (1997), by Ira Gaylon White, 288 pgs, softbound, indexed  

 ISBN 0-9703085-9-0          $40.00 
___OUR BEFORES - ANCESTOR CHARTS, VOL. 1, 250 pgs., (1982), indexed ISBN 0-9703085-1-5   $18.00 

___OUR BEFORES - ANCESTOR CHARTS, VOL. 2, 252 pgs., (1982), indexed ISBN 0-9703085-2-3   $16.00 

___OUR BEFORES - ANCESTOR CHARTS, VOL. 3, 176 pgs., (1986), indexed ISBN 0-9703085-3-1   $13.00 
___OUR BEFORES - ANCESTOR CHARTS, VOL. 4, 222 pgs., (1991), indexed ISBN 0-9703085-4-X   $16.00 

___OUR BEFORES - ANCESTOR CHARTS, VOL. 5, 247 pgs., (1996), indexed ISBN 0-9703085-5-8   $17.00 

___OUR BEFORES - ANCESTOR CHARTS, VOL. 6, 168 pgs. (2000), indexed. ISBN 0-9703085-6-6   $16.00 

___PROBATE RECORDS OF CHEROKEE COUNTY, TX, MINUTE BOOK A, 1870-1881 and DOCKET A and DOCKET B.,  

                  1867-1887 by Ogreta W. Huttash, 125 pages (2004), Softbound, Indexed.     $20.00 

___PROBATE RECORDS OF CHEROKEE COUNTY, TX 1846- ca 1875 by Ogreta W. Huttash, 200 pages (1998) Includes estates,  
 settlements,  guardianships for minors, community property of decedents, heirs, and the name of the surviving spouse. Slaves  

                  in estate settlements are indexed under the name of the owner. Softbound, indexed    $29.00 

___Providence Cemetery Cherokee County Texas  by Sylvia Booth Acker and Willie Harold Acker, Sr., ISBN 978-1-931167-42-0 
                   LCCN 2011909068                                                                                                   $12.00 

___Saga of Cherokee County, Texas. Book  1 indexed 417 pgs by Helen Wooddell Crawford  ISBN 1-931167-26-5   $33.00 

___Saga of Cherokee Book 2  1910-1921 indexed  491 pgs by Helen Wooddell Crawford ISBN 1-931167-24-9  $34.00 
___Saga of Cherokee,   Book 3 ass'td dates, indexed 433 pgs by Helen Wooddell Crawford $30.00 

___Saga of Cherokee Book 4 1922-1925, indexed  504 pgs by Helen Wooddell Crawford  ISBN 978-1-931167-48-2  $34.00 

___Saga of Cherokee Book  5, ass'td dates, indexed 471 pgs by Helen Wooddell Crawford  ISBN-10 1-931167-34-6    $45.00 
___Saga of Cherokee and World War I,  Book  6 indexed 256  pgs by Helen Wooddell Crawford $28.00 

___Saga of Cherokee County and Pioneer Life Book 7, indexed,  167 pgs, by Helen Wooddell Crawford ISBN 1-931167-28-1  $18.00 

 
___TREE TALK, THE FIRST FIVE YEARS, May 12,1975 through April 30,1980. Contains a brief history of the organization of the  

 Cherokee  County Genealogical Society,  charter membership roster, etc.. (1995), full name index (1998)  

 ISBN 1-931167-11-7          $11.00 
___Tree Talk, Volume I through Vol. 25, No. 3. (2000) Contains the complete text (about 3600 pages) of the 25 years of this  

 publication. 2 CD-ROMs. ISBN 0-9703085-0-7, ISSN 1551-0514, LCCN 2004204271     $30.00 

___Tyler Courier-Times-Telegraph 1950  Mid Century Edition.  275 pgs by Helen Wooddell Crawford   $24.00 
 



TREE TALK       Volume 36 Issue 2            Winter 2010-2011      Page 71     

 

Order Form 

This form may be used when ordering books from CCGS. Include .0825 tax (for TX residents only) on each 

item in the catalog. Also POSTAGE & HANDLING CHARGE of $3.50 for the first book plus $1.00 for each 

additional book ordered at the same time. List the book or books you wish to order and show the total amount be-

low. 

 

 Your Name:______________________________________________________________________ 

    

Address: ____________________________________________E-Mail___________________________ 

 (Street address or P.O. Box) 

____________________________________________________________________________________ 

(city or town)     (state)    (9-digit Zip code) 

 

 Total amount of order   $___________________________ 

 

 State sales Tax 

(if applicable)    $___________________________ 

 

 Postage & Handling   $___________________________ 

 

 TOTAL ENCLOSED   $___________________________ 

 

 Mail to:  Cherokee County Genealogical Sciety 

  P.O. Box 1332 

  Jacksonville, TX 75766-1332 

Quantity Title Price Extended 

Price 
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Membership Application 
 

  CHEROKEE COUNTY 

 

  GENEALOGICAL SOCIETY 

 

  Post Office Box 1332 

 

  Jacksonville, Texas 75766-1332 

 

  Annual membership dues are $15.00 (single) and $20.00 for a two-member household. The membership year 

ends August 31, 2012. Membership entitles you to four quarterly issues of our publication Tree Talk. Tree Talk is 

normally published the first week of October, January, April and July of each fiscal year. Members joining after 

the first issue is published will receive all issues of Tree Talk, but back issues of Tree Talk will be mailed with the 

next issue unless $1.00 for special handling is enclosed. The Society meets the second Monday of the months Sep-

tember through May at Bonner Plaza, 421 S. Bonner, Jacksonville, Texas at 7 p.m. 

 

  Date of Application ______________________________ Paid through 8/31/______________ 

 

  Single Membership $15.00________________  New Member____________________ 

 

   

 Two-Member household $20.00____________  Renewal________________________ 

 

   

 Name:__________________________________________________________________________ 

 

   

 Address:________________________________________________________________________ 

 

   

 City:_______________________ State:________________ 9-digit Zip Code___________________ 

 

   

 Phone Number (include area code):____________________ E-mail Address____________________ 

 

   

 Maiden Name (if applicable)__________________________________________________________ 

 

   

 Surnames you are researching;________________________________________________________ 

 

  _______________________________________________________________________________ 

 

Gift of _____________________________, bill to: _________________________________________   

 Complete the information above, make out your check, and mail to:  

 

   Cherokee County Genealogical Society  

  

 Post Office Box 1332 

 

            Jacksonville, Texas 75766-1332 


